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Introduction

Legal Aid Ontario staff interacts with each other, stakeholders, government, and clients every day. Numerous written and verbal communications explain who we are, what we do, and the services we provide. It is important that all our clients have access to easy to read and understand information about Legal Aid Ontario, including those with mental, physical, sight, hearing, and language disabilities.

By establishing and adhering to print accessibility, writing, and style guidelines, we can ensure that all our clients have access to information about LAO.

Accessibility

The Government of Ontario passed the Accessibility for Ontarians with Disabilities Act (AODA), 2005 that requires publicly funded organizations make their facilities, practices, programs and publications and Internet sites more accessible and inclusive.

Mandatory Standards have not yet been established under the AODA. However LAO has undertaken to improve accessibility in anticipation of standards being passed. The enclosed print accessibility guidelines are well established and accepted within the disability community. The guidelines were developed with resources from CNIB, Royal National Institute of the Blind, (UK), and Lighthouse International (USA) and have been reviewed by ARCH Disability Law Centre.

Writing and Style

The Communications and Public Affairs Department compiled this writing and style guide to help managers, new staff and other LAO staff communicate in print and on the Web. The writing and style guidelines identify standards and preferences based on four standard reference works. The Canadian Press Stylebook, Caps and Spelling, The Ontario Public Service Correspondence Style Guide and the Website: http://www.plainlanguagenetwork.org/plaintrain/IntroducingPlainLanguage.html.
Back
1) Font

Serif fonts, with their 'ticks' and 'tails' at the end of most strokes (as found in traditional print fonts such as Times New Roman), tend to obscure the shapes of letters. Sans-serif fonts are more legible when character size is small, so sans-serif fonts are preferred.
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Arial 12 point (pt) is the standard font for all LAO documents and publications.
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2) Font Style

Using upper and lower case is more readable than italics, oblique or condensed.

Upper and lowercase type is effective. Italic type is not as effective.
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3) Font Size

Type should be at least 12 pt, larger if possible. Titles and highlighted copy should have a larger font size of at least 18 pt when possible. It is also important to keep in mind that the relationship between readability and point size differs somewhat among typefaces.

This font size is too small
 Arial 8 pt

A 12 pt font size is easier to read
Arial 12 pt
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4) Font Colour

Text should be printed with the highest possible contrast. For many readers who are older or who have low vision, light (white or light yellow) letters on a dark (black) background are more readable than dark letters on a light background.

Very high contrasts are difficult to achieve with colour combinations other than black and white. Therefore printed material is generally most readable in black and white. Using different colours may be important for aesthetic or other reasons, but it is best to use colour only for larger or highlighted text, such as headlines and titles.

Two colours that contrast sharply for some persons may be far less distinguishable to a person who has an impairment of colour vision. It is important to appreciate that it is the contrast of colours one against another that makes them more or less discernible rather than the individual colours themselves.
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Exaggerate lightness differences between foreground and background colours, and avoid using colours of similar lightness adjacent to one another.
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Avoid using red and green whenever possible.

Back
5) Letter Spacing

Text with close letter spacing can present difficulties for readers who have low vision. Where possible, spacing should be wide. Monospaced fonts, fonts in which every character is the same width (usually, font width is variable; the "w" and "m" are wider than most letters, and the "i" is narrower) are more legible for readers.

This letter spacing is effective.

This letter spacing is not effective.
Changing Letter spacing in Microsoft Word:

1) Click on the Format menu item at the top of the word screen.
2) Select Font and choose the character spacing option.
3) From the spacing drop down menu, choose ‘Normal’or ‘Expanded’.
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6) Leading

Many people with low vision have difficulty finding the beginning of the next line while reading. Leading, or spacing between lines of text, should be at least 25 to 30 percent of the point size (see instructions below for changing leading in Word documents).

Effective Leading:

Leading, or spacing between lines of text, should be at least 25 to 30 percent of the point size. This is because many people with low vision have difficulty finding the beginning of the next line while reading.

Ineffective Leading:

Leading, or spacing between lines of text, should be at least 25 to 30 percent of the point size. This is because many people with lowl vision have difficulty finding the beginning of the next line while reading.

Changing Leading in Microsoft Word:

Line spacing can be increased or decreased by a percentage that you specify. For example, setting line spacing to 1.2 will increase the space by 20 percent, while setting line spacing to a multiple of 0.8 will decrease the space by 20 percent. Setting the line spacing at 2 is equivalent to setting the line spacing at Double.

1) Click on the Format menu item at the top of the word screen.
2) Select Paragraph and choose the line spacing option.

3) Select ‘multiple’ in the line spacing drop down menu.

4) Enter at least 1.2 in the options box.

Back 

7) Margins

Extra-wide binding margins are especially helpful in bound material because it makes it easier to hold the volume flat. Spiral binding can be helpful as well. Many visual devices, such as stand- and video-magnifiers, are easiest to use on a flat surface.
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8) Navigational Aids

It is helpful if recurring features, such as headings and page numbers, are always in the same place. A contents list and rules to separate different sections are also useful. Leave a space between paragraphs as dividing the text up gives the eye a break and makes reading easier.
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9) Paper Finish

Paper with a glossy finish can lessen legibility because many people who are older or who have low vision also have problems with glare. Ensure that the bond of the paper is heavy enough so that text printed on one side of a page does not show through to the other.
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10) Distinctiveness

Visual disability often makes it difficult to find a book or other document that is buried among similar publications, especially for sets with volumes that differ only in title or number. Use of distinctive colors, sizes and formats on the covers can be especially helpful to older individuals and those who have low vision.

Example:
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11) Forms

Persons who have low vision tend to have handwriting that is larger than average, so allow extra space on forms. This will also benefit people who have impairments that affect the use of their hands, such as arthritis.
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12) Alternative Formats

When creating documents and publications that are widely distributed, consideration should be given to making these documents available in an alternative formats.

Large Print Documents

Font Size

Large print font size should be at least 18 point.

The majority of printed information is generated

by word processors, so it is possible to print off

copies in the font size requested to meet

individual needs.

It is recommended that large print be used as a matter of course for any documents aimed at older people who are more likely to have a visual impairment.

Bold, Underline and Italics

Bold and underlining should be used to highlight specific sections in the text such as headings, quotations, or areas that need identifying.

Italics should not be used because it distorts the typeface, making information potentially difficult to read.

Line Spacing

Leading, or spacing between lines of text, should be at least 25 to 30 percent of the point size. (See Leading

Headings

Large print headings and subheadings should be larger and bolder than regular large print text. Bold or underlining can be used to highlight headings.

Justification

Paragraphs in large print should be block style and use 2.5 cm (1 inch) margins. The left margin should be justified and the right margin should not be justified; there should be no indentations to delineate paragraphs.

Columns and Divided Words

Where possible, columns and divided words should be avoided.

Graphics

Large print should not be used over a background design or other graphical material.

Large print users should have access to graphics that are not only enlarged, but maintain the same contrast, clarity, and access to appropriate colouration as those prepared for their sighted peers.

Large print materials that are graphical in nature, such as maps, graphs and charts, should also adhere to type size, font, and other large print guidelines.

When colour is not possible, high-quality, black, line drawings are preferred over grey scale.

Computer Readers and Electronic Documents

Many people with visual disabilities use computer readers: hardware and software that reads electronic documents out loud. Computer readers are most effective at reading plain text. Graphics, non-linear layouts, and text boxes are not decipherable by electronic readers. The following guidelines should be applied to documents intended to be read by computer readers.

Word's style sheets (Templates): Style Sheets and Templates allow users to preset all formatting options such as the font, spacing, bold and italics and can be used for titles, headings, and paragraphs of text to provide structure to a document.

Documents should be saved in both a Microsoft Word and plain text format as these are the two formats that are most compatible with computer readers.

Saving Documents in Plain Text format:

1) In an open Word document, in the File menu, select ‘save as’

2) In the save Window, click on the ‘save as type’ drop down menu and choose ‘Plain Text’

Table of contents: Create a linked table of contents to provide orientation and quick navigation to sections of a document.

Avoid text boxes: Text boxes are inaccessible to screen readers.

Create linear tables: Because screen readers read across the page a line at a time, tables should only be used if they make sense when read from left to right and when headings are used for columns and rows.

Avoid multi-column layout: Columns are difficult for people with
intellectual disabilities and users of screen-magnifiers to navigate.

Use Footnotes: Use footnotes rather than endnotes - it is easy to navigate to/from these.

Provide Alternative Text: Add a text equivalent to all graphs, diagrams, and images and describe the feature of the graphic in the nearby text. Use relative positioning to ensure that they stay with the appropriate heading/paragraph if the text is resized.

Braille

Braille is a method of reading by touch using a system of raised dots. There are dot combinations that correspond to letters of the alphabet, numbers, punctuation, symbols and common letter groups.

A braille translation program and a braille embosser are needed to produce braille in-house. The braille translation program converts the text into a format that can be outputted to a braille embosser, i.e., braille “printer”.

Spoken Word Audio

Spoken word audio on tape or CD is an effective means of communication. It is also ideal for people who have learning impairments or low literacy levels or some persons who have manual impairments.

Computer Disks and CD-ROMs

Computer disks (or perhaps CD-ROMs) may be the preferred format of persons who are blind or who have low vision or of persons who have learning disabilities. If you are providing information on disk, the file should be in more than one format, preferably Word and plain text, to ensure that persons who have low vision can read it and it is compatible with computer readers.
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13) Editing

· Shorten or remove redundant and ineffective words, phrases or sentences.

· Replace long words with short ones.

· Use active rather than passive voice.

· Check to see whether the most important information is placed near the beginning of the document.

· Avoid using jargon or clichés in your writing.

· Be careful using legal terms and phrases - make sure your audience is familiar with the terms you use.

· Check facts, telephone numbers, e-mail and Web addresses for accuracy. For a major document, fact checking should be a distinct process involving some research. All communications, no matter how brief, warrant a check of any important factual information.

· If possible, arrange for someone from your intended audience to read your draft
and identify any points that would benefit from improved flow, logic or clarity.
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14) Proofreading

Proofreading can help you identify any of the errors or imperfections listed in the editing list. Proofing, however, is the last step before sign-off for publication. It is usually limited to scrutiny for blatant errors rather than a review for stylistic improvements.

· If proofing your work, start by using the automated spell-check in your word processor to identify possible errors.

· Read or scan the material once in its entirety to check for problems such as: spelling errors in a heading or information in a caption that does not appear to correspond with what you see in the photograph.

· Start again and check words for misspellings and incorrect usage. In this step, avoid getting caught up in the flow of the writing, a situation in which your eyes tend to see what they expect to see rather than what is actually on the page or computer screen.

· Carefully double-check all numbers, dates and telephone numbers.

A computer spell-check function is available in Microsoft Word. The automated spell-check helps identify basic errors in spelling. However, the automated spell-check will not catch errors (typos) that produced a different word that is spelled correctly (and instead of are or trial and trail). The grammar-check featured in Word is useful for flagging down passive voice and run-on sentences.

In addition, the automated spell-checklist does not catch homonyms (to/too) and may not be set up to check for Canadian spelling practices (-or/-our).

Back 

15) Sentences and Paragraphs

Sentences should be grouped in paragraphs with no more than four or five sentences to provide a logical sequence for reading and understanding. Sentences should average 15 words in length or less and no sentence should be longer than 25 words.

Tips and Reminders:

· Write in an active voice rather than using passive sentences. Active voice involves stating the source of, or responsibility for, the action described. Example of active voice: The team leader announced a new strategy for the project. Passive voice: A new strategy for the project was announced.

· Keep it simple. Keep your sentences and paragraphs short and to-the-point. Avoid using long complicated sentences. They may be difficult to read and obscure the message. Shorten long sentences by deleting non-essential words or phrases. Sometimes two brief sentences are more effective than one long one.

· Keep in mind the importance of having links or verbal clues that contribute to coherence and a sense of logical flow from sentence to sentence and from one paragraph to another. For example, you might want to start a new paragraph with a phrase such as "In addition" to link it with the preceding sentence or paragraph.

· Emphasize the positive. Positive sentences are inviting and encourage people to read on. Negative sentences can seem bossy or hostile. They can cause your reader to mistrust your words and often discourage people from reading on. However, negative phrasing is appropriate for emphasizing dangers, pitfalls, or other warnings. Instead of: If you fail to pass the examination, you will not qualify, use: You must pass the examination to qualify for admission.

Use appropriate words within a sentence. Use simple, familiar words instead of unfamiliar words. Write as if someone is asking you what you mean. If you are writing for a diverse audience, sometimes you might be an interpreter as well as a writer. Here are a few examples of words and phrases you might substitute.

Instead of:
Use:
Instead of:
Use:
accomplish
do
with regards to
about

ascertain
find out
in the event that
if

assist
help
during such time
while

facilitate
make easier
in view of the fact
because

formulate
work out
it would appear that
apparently

in lieu of
instead of
pursuant to
about

initiate
plan
adequate number of
enough

obtain
get
excessive number of
too many

utilize
use
at the present time
now

http://www.techcommunicators.com/diction.html provides a list of difficult words and phrases, along with their plain language alternatives.
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16) Bulleted Lists

There are three basic types of lists:

Type 1 Lists that contain only a few words in each item and do not contain a full verb phrase.

Type 2 Lists of items, which combine to form one giant sentence with each item completing the partial sentence, interrupted by a semicolon

Type 3 Lists of items that are at least one independent sentence.

Remember: Each item in a list should have parallel style, for example, starting every bulleted item with a verb.

Type 1 Must be introduced by a grammatically complete sentence that introduces the coming list of nouns, noun phrases etc. Items are brief, and only a few words. Each item begins in lowercase and no punctuation follows.

The College has introduced several new programs for the upcoming year:

· information technology

· business and society

· business and economics

Type 2

Must be introduced by a grammatically incomplete sentence. All items are lowercased and end with a semicolon except the final one, which has a period to end the sentence.

The public demanded that the government:

· take steps to end corruption among party officials;

· institute political reforms leading to more democracy and less authoritarianism;

· end martial law in the capital.

Type 3

Must be introduced by a grammatically complete sentence, often containing an anticipatory word tipping off the reader a list is to follow. All sentences within the list should begin with a capital and end with a period.

The students listed several demands:

· The cost of tuition be lowered by 10 per cent over the next three years.

· Classroom sizes be limited to 30 to 40 students.

· Both activity fee and health fees be optional.
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17) Abbreviations and Acronyms

· Abbreviations can be convenient for both writer and reader, as long as readers understand the abbreviations. It is essential to spell out words the first time an expression or organization's name appears in the document.

ƒ Example: Legal Aid Ontario (LAO) helps almost 1 million people every year. LAO...

· Abbreviations that have become household terms are acceptable in all references. That is, they need not be spelled out, though the full word or phrase may provide a more graceful reading.

ƒ Example: RCMP, NDP, CBC

· An acronym is an abbreviation pronounced as a word. They are formed from the first letter of the words that they represent. Avoid using periods with acronyms.

· Example: AIDS (acquired immune deficiency syndrome), NATO (North Atlantic Treaty Organization).

· Acronyms that have become words are not capitalized.

· Example: radar (radio detection and ranging), scuba (self-containing underwater breathing apparatus).

In formal writing, try to avoid ending a sentence or list with the abbreviation etc. Instead, complete the list as a courtesy to the reader or indicate an incomplete list by introducing it with a phrase such as “for example” or “includes”.

Similarly try to avoid using the Latin abbreviations such as e.g. (meaning for example), i.e. (that is), et al. (and others) and cf. (compare).
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18) Numbers

Use the following guidelines, which are consistent with The Canadian Press Stylebook.

· In general, spell out whole numbers below 10 and use figures for 10 and above. Examples: four, seven, 15, 7,500

Use figures for fractions: 6.25

· When a sentence begins with a number, spell it out even if the number is more than 10.

Example: Seventy-five people and 25 children boarded the ferry.

ƒ Do not write out a year in words, and try to avoid starting a sentence with a year. ƒ Round numbers in the thousands are usually given in figures.

· Use figures for numbers up to 999,999. Above that, switch to words if absolute precision is not required.

Example: a loss of $100,000, a $1.5 million project

· Informal and casual usage: Donations poured in by the hundreds and thousands. Damage was in the millions.

· Use commas to set off numbers of four or more figures except house, page, telephone, year and other serial numbers.

Example: 2,500; 100,000 billion;

1234 Main Street; p. 1250
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19) Capitalization

This issue of capitalization can be very challenging for many writers. Keep these two principles in mind:

1. Less capitalization means less formality.

2. Excessive capitalization can affect the reader's flow.

Capitalizing job titles

When the title comes before the name, it should appear in capital letters.

· President Xxxxx Xxxxx

· Vice President Xxxxx Xxxxx

· Area Director Xxxxx Xxxxx

· Executive Director Xxxxx Xxxxx

When the title comes after the name, it should appear in lower case.

· Xxxxx Xxxxx, president of

· Xxxxx Xxxxx, vice president of

· Xxxxx Xxxxx, area director

· Xxxxx Xxxxx, executive director

When the title is written without the name, it should appear in lower case.

· The president made a speech to...

· The vice president addressed...

· The area director announced...

Capitalize Crown when referring to the supreme governing power.

· The Crown dropped the charge.

· The matter was in the hands of the Crown attorney.

Government Departments

Capitalize specific international, national, provincial and state government departments, ministries, agencies, boards, including short forms of the proper name.

(Government of Ontario but the government for general reference)

· Capitalize awards, honours and declarations Order of Canada, Order of Merit

· Capitalize specific proper names Web site, Internet, Web master

· Lowercase descriptive or generic terms e-mail, home page

• Capitalize superior courts Supreme Court, Appeal Court

· Lowercase divisions The appeal division

· Lowercase family courts

· Lowercase local government councils, departments and boards Peel regional council, Ontario development department, Simcoe board of education

· Capitalize proclaimed laws, treaties, important legal codes and historic documents Charter of Rights, Criminal Code
· Lowercase provincial, state and regional legislatures and local councils Ontario legislature, Ontario provincial department, Peel regional council

Caps and Spelling

The following table shows the correct use of lower and upper case in English. Rules for French will vary depending on the type of document. Letter writing protocol in French differs from English. Please refer to a French stylebook or to the FLS Coordinator.

	English
	French

	Note: the rules for capitalization are often different in French. Check the table and make sure you’re using the right rule for the right language.

	access to justice
	accès à la justice

	Act – Capitalize and italicize acts but not subsequent references when the full name is not used.
	Loi – On met la majuscule au premier mot des titres de lois. Le titre des lois s'écrit en italique. Quand le mot loi ou règlement est employé elliptiquement, on maintient l'italique. Dans les autres cas, le mot s'écrit en romain.

	adjudicator
	arbitre

	administration, administrative staff
	administration, personnel administratif

	advisory council
	conseil consultatif

	area committee
	comité régional

	area office
	bureau régional

	area director
	directeur régional (masc.)
directrice régionale (fém.)

	attorney
	avocat (masc.) avocate (fém.)

	attorney but Attorney General Xxxx Xxxx
	procureur général (masc.) Xxxx Xxxx procureure générale (fém.) Xxxx Xxxx

	Awards – capitalize specific awards
	Prix – Il faut mettre une majuscule au

« complément » du prix. Ex. : le prix Fémina

	Bar Admission Course
	cours de formation professionnelle du barreau

	bill but Bill 101
	projet de loi - Les projets de loi, toujours désignés par un numéro, prennent la minuscule. On emploie le romain dans le cas des projets de loi désignés par un numéro. Ex. : Le projet de loi 101

	board of directors
	conseil d’administration, conseil

	bylaw (no hyphen)
	règlement municipal

	called to the bar, members of the bar
	admis au barreau (masc.)

admise au barreau (fém.)

membre du barreau (masc. et fém.)


	Canadian government but Government of Canada
	gouvernement canadien, gouvernement du Canada

	case worker
	agent chargé des dossiers (masc.) agente chargée des dossiers (fém.)

	Chair – when you are referring to someone’s title to distinguish it from other meanings.
	le président du conseil d’administration (masc.) la présidente du conseil d’administration (fém.)

	city council, city hall (administration), City Hall (building), City of Toronto but in the city of Toronto
	conseil municipal, hôtel de ville (administration), Hôtel de ville (édifice), Ville de Toronto (entité administrative), mais dans la ville de Toronto

	College – capitalize the names of universities and colleges
	Collège – le nom des collèges et des universités prend une majuscule initiale seulement, à moins que le nom contienne des noms propres.

Ex. : Université laurentienne, Université d’Ottawa.

	Commission – Capitalize the proper names of government commissions – Canadian Transport Commission but the transport commission
	Commission – Il faut mettre une majuscule au nom propre des commissions gouvernementales – Commission des transports du Canada, mais la commission des transports (en général)

	community legal clinic but Lake Country Community Legal Clinic
	clinique juridique communautaire, mais Clinique juridique communautaire de Prescott et Russell

	councillor (Coun.) – Coun. Xxxx Xxxx but a city councillor
	conseiller municipal (masc.)

conseillère municipale (fém.)

Marie Tremplay, conseillère municipale le conseiller municipal Jean Beauchamp

	counsel, Crown counsel
	avocat (masc.)

avocate (fém.)

procureur de la Couronne (masc.) procureure de la Couronne (fém.)

	courthouse
	palais de justice

	courtroom
	salle d’audience

	court of law
	tribunal

	Criminal Code
	Code criminel – Comme il s’agit du nom d’une loi, on utilise l’italique.

	criminal lawyer
	avocat au criminel (masc.) avocate au criminel (fém.)

	duty counsel
	avocat de service (masc.) avocate de service (fém.)

	family law lawyer
	avocat en droit de la famille (masc.) avocate en droit de la famille (fém.)

	federal, federal government
	fédéral, gouvernement fédéral

	Government of Ontario, but the Ontario government
	gouvernement de l’Ontario, gouvernement ontarien


	Governor General – Capitalize in all references (Canada)
	gouverneur générale (masc.)

gouverneure générale (fém.)

Le titre de fonction prend toujours la minuscule.

	His/Her Majesty
	Sa Majesté (masc. et fém.)

	jail, county jail
	prison, prison de comté

	Justice Sidney Linden but the justice said...
	monsieur le juge Sidney Linden, mais le juge a dit...

	lawyer
	avocat (masc.) avocate (fém.)

	legal aid certificate
	certificat d’aide juridique

	Legal Aid Services Act, the Act, LASA
	Loi sur les services d’aide juridique, la Loi

	legal aid tarif
	le tarif de l’aide juridique

	Legislatures – Capitalize national legislatures, lowercase others.
	Assemblée législative (provincial); Assemblée nationale (Québec); Parlement (fédéral)

	mayor, Mayor Xxxx Xxxx
	maire (masc.)

mairesse (fém.)

le maire Jean Pelletier la mairesse Savoie

	Parliament (national legislature), parliament (provincial or regional), Parliament Buildings
	Parlement (fédéral), édifice du Parlement

	Prime Minister Jean Chrétien but the prime minister in general reference
	le premier ministre Jean Chrétien, la première ministre Xxxx Xxxx.

	pro bono
	bénévolat, bénévole

	province, province of Ontario
	province, province de l’Ontario, Ontario (par économie)

	provincial office
	bureau provincial


Singular or Plural - using the word staff

· The staff is (singular) excited about the upcoming GEM awards.

· The staff are (plural) excited about the upcoming GEM awards. Both examples are acceptable but the plural is preferred.
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20) Dates

· Write specific dates within the body of the text as follows, abbreviating the month. Example: Saturday, Sept. 19, 1995, Wednesday, Nov. 25

Do not change the order - Saturday, 19 Sept.

· The months of March, April, May, June and July are never abbreviated because the words are short. They are instead written out in full.

Example: May 10, 1990, Monday, July 5, 1995

· For dates that are distant, omit the weekday Example: July 15, 2003

· Name the day if it falls within seven days of the current date. Example: on Tuesday, next Saturday, last Friday

· When writing approximate dates within the body of a text, spell out the month in full. Example: During January (month only)

· Avoid commas when you are referring to a specific month with a specific year. Example: Beginning in September 2003 (no comma, month spelled out in full)

· When writing about decades, use numbers. Example: The 1970s, the 1980s, the 90s, the mid-1960s

· When writing about periods of time over years, write the numbers out in full using a hyphen, not a slash

Example: 1990-1995 (not '90-'95), 2001-2002 (not 2001-'02)

· Use on when it helps readability or break up a series of capitalized words. Example: The measure passed in the House of Commons on Monday, The Toronto Maple Leafs defeated the Montreal Canadians on Saturday.
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21) Colon and Semicolon

· Use a colon, rather than a comma, to introduce a direct quotation longer that a short sentence.
Example: Winston Churchill said in 1942: "This is not the end. It is not even the beginning of the end. But it is perhaps, the end of the beginning."

ƒ Use a colon in lines introducing lists, texts and tables.

· Use a colon to introduce an example, a formal question or quotation. It can replace for example, namely, that is.

Example: It was a mixed cargo: iron ore, wheat and coal.

· Generally do not capitalize the first letter of a sentence that follows a colon; but a capital may be used if emphasis is desirable.

ƒ Use colons in question-and-answer formats and for interviews.

· Use a semicolon to separate statements too closely related to stand as separate sentences.
Example: "I never read a book before reviewing it; it prejudices a man so." (Sidney Smith)

· Use a semicolon to separate phrases that contain commas.
Best actor, Robert De Niro, Raging Bull; best actress, Sissy Spacek, Coal Miner's Daughter.

· Use a semicolon to precede explanatory phrases introduced by for example, namely, that is and the like when a comma seems too weak.
Example: Some pleasures cost next to nothing; for example, reading.

· Semicolons go outside quotation marks. Police finally cornered the "bear"; it was a poodle.

· Use colons to separate titles and subtitles. Example: The Chinese: Portrait of a People

· Put colons outside closing quotation marks. Example: She was referring to "the most serious of all charges": murder.

· Use a colon to mark a strong contrast. Example: Eating isn't just a necessity: it's a pleasure.
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22) Plain Language

There are many misconceptions about plain language. Plain language is not a simplified style of writing, nor is it language that puts grammatical perfection ahead of clarity. It does not involve oversimplifying the message so that it loses its precision, force or effect. Instead, it is a way of organizing and presenting information so that it makes sense and is easy to read for the intended audience.

Here's why you should use plain language:

· It saves both the reader and writer time.

· It creates a good image for the organization.

· According to Statistics Canada, 48 per cent of Canadians have low literacy skills.

· Short, clear and concise text has more impact on your audience and is more likely to be understood.

Ask yourself the following questions to help you focus your writing and get your message across more effectively.

1) Who is your audience?

· Plain language starts with the commitment to learn as much as you can about your audience. This will help you develop useful and effective material.

· Plain language includes consulting with your audience so that your message is what they want to know and what they need to know.

· Keep in mind that your readers are probably less familiar with your subject than you are. It will help you decide what the reader needs to know instead of what you want to write.

· When writing for the general public, material should be written as though you're writing for a student in grade eight..

2) Why are you writing this document?

· Are you writing something completely new? Give your readers all the background information they need to understand. Try to link new information to what that the reader may already know.

• Is the document a "how-to" text? Be sure it includes any background information needed to understand your instructions.

· It may be difficult to single out one purpose but a document with one primary focus is more likely to communicate its message more effectively.

3) What do you want to say?

· Focus on what the reader wants to know. Don't try to say more than you have to. Your readers' needs and wants should determine what information gets the most emphasis in your documents.

· Keep it focused. You don't need to tell the reader everything you know about the topic in order to communicate what is needed.

4) How will your reader use this information?

How people use your document should help you decide how to best organize the information in it. Be clear what you expect the reader to do after reading it.

· Will your document be a quick reference tool?

· Is the reader supposed to do something after reading the document?

· Is the reader supposed to remember certain information?

· Is the reader supposed to agree with your point of view?

Use strong verbs and avoid turning verbs into nouns.

· "The man sauntered up the road" is longer than "the man walked up the road." Notice how different pictures are formed in the reader's mind by the use of different verbs such as crept, scurried or staggered.

Turning a verb into a noun weakens the sentence.

· "We made a determination" is weaker than "we determined."

· "We will make a distribution" is weaker than "we will distribute."

· "The requirement of the department" is weaker than "the department requires."

Omit unnecessary, useless and weak words.

• "There are three other considerations that outweigh..." "Three other considerations outweigh..."

· "The state court had proposed that there be a bellwether trial..." "The state court had proposed a bellwether trial..."

· "There has been a great deal of discovery and other work done..." "Much discovery and other work has been done..."

· "An example would be..." "An example is..."

Flesch Kincaid Test - When Word finishes checking spelling and grammar; it can display information about the reading level of a document. For example; a score of 8.0 means that an eighth grader can understand the document.

Under the Tools menu, click Options, and then click the Spelling and Grammar tab and make sure there is a check mark in the Show readability statistics box.
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23) Writing for the Web

A Web site is a great way to get your message across to a large number of people. Keep in mind that writing for the Web is not the same as for print media, and requires a different strategy.

Keep in mind that:

· More than 75 per cent of users scan the page instead of reading word-for-word.

· Reading from the computer screen is 25 per cent slower than from paper.

· The average user takes less than 15 seconds to decide whether or not he/she will stay on the site.

Web pages have to employ scannable text using:

· Highlighted keywords

· Meaningful subheadings

· Bulleted lists
· One idea per paragraph

Tips for writing for the web

ƒ Your online copy should be 50 per cent shorter than the print version.

· Write tighter and meatier than you would for print. Remember that your readers can click away at any second, so try to keep their attention by sticking closely to your topic.

· Be generous with paragraph breaks and headings - they make pages a little more eye-friendly and easier to scan. Don't be afraid to use things like bulleted lists and tables - they make the info jump out at the reader.

· Divide information into meaningful sections, then hyperlink those sections together.

· No matter what you're writing, never bury the lead. Web users are often inpatient and critical; write in the "news you can use" style to allow users to quickly find the information they want.

· Your online copy should "sound" different from your print version - more intimate, more informal and more human. The best voice for your material is me-to-you, one-to-one, targeted to your reader and appropriate to your subject matter.

Back







